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Introduction to HIPAA Protocol
This section briefly describes the HIPAA mandated X12 transactions and their use for 
electronic data interchange (EDI). For a complete description of HIPAA and the mandated 
X12 transactions, refer to the HIPAA Educational Materials on the CMS website: 
http://www.cms.hhs.gov/EducationMaterials.

For a complete description of the X12 EDI standard, refer to the standard itself, which can 
be found at the Data Interchange Standards Association (DISA) website: 
http://www.disa.org.

Overview
The Health Insurance Portability and Accountability Act of 1996, known as "HIPAA" is a 
federal law that covers a number of important health care issues, such as providing 
consumers with greater access to health care insurance, and ensuring the privacy of 
healthcare data. The law also includes measures designed to reduce administrative costs in 
the healthcare industry by providing standards for electronic transactions between the 
various entities within the industry, such as health care providers and insurers. 

The Administrative Simplification portion of the law deals with electronic transactions and 
code sets requirements. TIBCO BusinessConnect™ Container Edition - EDI Protocol HIPAA 
Edition powered by Instream® provides additional functionality for TIBCO 
BusinessConnect™ Container Edition - EDI Protocol powered by Instream® customers to be 
compliant with the electronic transactions and code sets requirements of the 
Administrative Simplification portion of HIPAA. 

BusinessConnect™ Container Edition - EDI Protocol HIPAA Edition powered by Instream 
also provides validation of National Provider Identifiers (NPI), which is another part of 
HIPAA’s Administrative Simplification.

Electronic Transactions
HIPAA transactions are  the electronic transfer of health care information for specific 
purposes. Under HIPAA, if a health care provider engages in one of the identified 

http://www.cms.hhs.gov/EducationMaterials
http://www.disa.org/
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transactions, they must comply with the standards for that transaction. HIPAA requires 
every provider who does business electronically to use the same health care transactions, 
code sets, and identifiers. 

The electronic transaction standards for the healthcare industry are specified by the ASC 
X12N Subcommittee of The American National Standards Institute (ANSI) and the National 
Council for Prescription Drug Programs (NCPDP). The NCPDP standard formats are used by 
retail pharmacies for drug claim transactions.

The following is a list of the electronic transaction standards mandated by HIPAA:

 l For claims or encounters:

 o ASC X12N 837 Institutional (versions 4010X096A1 and 5010X223A2)

 o ASC X12N 837 Dental (versions 4010X097A1 and 005010X224A2)

 o ASC X12N 837 Professional (versions 4010X098A1 and 005010X222A1)

 l For Remittance Advice

 o ASC X12N 835 (versions 4010X091A1 and 005010X221A1)

 o ASC X12N 820 (versions 4010X061A1 and 005010X218)

 l Eligibility Inquiry and Response

 o ASC X12N 270 (versions 4010X092A1 and 5010X279A1)

 o ASC X12N 271 (versions 4010X092A1 and 5010X279A1)

 l Prior Authorization and Referral

 o ASC X12N 278 (versions 4010X094A1 and 005010X217)

 l Claims Status Inquiry and Response

 o ASC X12N 276 (versions 4010X093A1 and 005010X212)

 o ASC X12N 277 (versions 4010X093A1 and 005010X212)

 l Benefit Enrollment and Maintenance

 o ASC X12N 834 (versions 4010X095A1 and 005010X220A1)

 l NCPDP retail pharmacy transactions (version 5.1 for telecommunications,   version 1.1 
for batch transactions)
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Document Structure
HIPAA transactions are specialized versions of X12 transactions. As such, a HIPAA document 
has the same structure and uses the same delimiters as the X12 document. To understand 
the structure of an X12 document and the use of delimiters in the X12 document, see the 
"Document Structure and Delimiters" topic in TIBCO BusinessConnect™ Container Edition - 
EDI Protocol powered by Instream® X12 Configuration.  

Acknowledgments
The information in the section on Acknowledgments in TIBCO BusinessConnect™ Container 
Edition - EDI Protocol powered by Instream® X12 Configuration also applies to HIPAA 
transactions.

Additionally, BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by 
Instream supports application level acknowledgments that are used to provide the 
validation results on the HIPAA-specific business rules for a transaction. For more 
information about the application level acknowledgments that are specific to 
BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream, see 
HIPAA Acknowledgement Properties.

Design Time Validation of HIPAA Transactions
BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream is 
used for runtime validation of HIPAA electronic transactions. For design time validation of 
HIPAA electronic transactions, use TIBCO Foresight® HIPAA Validator® Desktop. 

To use the guidelines provided with BusinessConnect Container Edition - EDI Protocol 
HIPAA Edition powered by Instream in TIBCO Foresight® HIPAA Validator® Desktop, you 
need to copy the HIPAA guidelines from BusinessConnect Container Edition - EDI Protocol 
HIPAA Edition powered by Instream into the appropriate directory for TIBCO Foresight® 
HIPAA Validator® Desktop.

Example: For design time validation of a version 4010 837 Professional transaction, perform 
the following:

Change directory to bcce-edihipaa-1.0.0_
InstallerFolder>/samples/sampleDocs/guidelines/4010_txns copy PDSA837P.std 
to configuration folder of bcce-cms container.
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See  TIBCO Foresight® HIPAA Validator® Desktop documentation for directions on how to 
use the product to perform validation.

To see a list of the guidelines for each HIPAA transaction, see HIPAA Transaction 
Configuration.

HIPAA Architecture
The following figure shows the HIPAA architecture in which a variety of organizations 
exchange HIPAA X12 transactions.

Figure 1: HIPAA Architecture

Hospital Physicians’ Group
Insurance 
Company

Government 
Service

Host 
Server

HIPAA 
Gateway

Host 
Server

Internet

Host 
Server

Terminal

Terminal

Terminal

Physician’s 
PC

Data Data

Physician’s 
PC

Physician’s 
PC

HIPAA Transactions Business Model
The following figure shows the HIPAA transactions business model.
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Figure 2: HIPAA Transaction Business Model
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HIPAA Types of Testing
There are seven types of testing recommended for HIPAA transactions. The seven types of 
testing are those defined in the Transaction Compliance and Certification white paper from 
WEDI-SNIP.

The following information on testing types is from that white paper.

• Type 1: EDI Syntax Integrity Testing: To test an EDI file for valid segments, 
segment order, element attributes, and numeric values in numeric data elements, 
validation of X12 syntax, and compliance with X12 rules.

• Type 2: HIPAA Syntactical Requirement Testing: To test for HIPAA Implementation 
Guide-specific requirements, such as repeat counts, used and not used codes, 
elements and segments, required or intra-segment situational data elements. 
Testing for non-medical code sets as laid out in the implementation guide and 
values noted in the Implementation Guide through the X12 code list or table.

• Type 3: Balancing: To test the transaction for balanced field totals, financial 
balancing of claims or remittance advice, and balancing of summary fields, if 
appropriate.

• Type 4: Situation Testing: The testing of specific inter-segment situations described 
in the HIPAA Implementation Guides, such that if A occurs then B must be 
populated. This is considered to include the validation of situational fields given 
values or situations present elsewhere in the file.



TIBCO BusinessConnect™ Container Edition - EDI Protocol HIPAA Edition powered by Instream® Configuration

10 | Introduction to HIPAA Protocol

Example: If the claim is for an accident, the accident date must be present.

• Type 5: External Code List Testing: To test for valid Implementation Guide-specific 
code list values and other code sets adopted as HIPAA standards. This level of 
testing not only validates the code sets but also makes sure that the usage is 
appropriate for any particular transaction and appropriate with the coding 
guidelines that apply to the specific code list. Validates external code sets and tables 
such as CPT, ICD9, CDT, NDC, status codes, adjustment reason codes, and their 
appropriate use for the transaction.

• Type 6: Product Types or Line of Service Testing: This testing is required to 
ensure that the segments or records of data that differ based on certain healthcare 
services are properly created and processed into claims data formats. These specific 
requirements are described in the Implementation Guide for the different product 
types or lines of service. 

Example: Ambulance, chiropractic, podiatry, home health, parenteral and enteral 
nutrition, durable medical equipment, psychiatry, and other specialized services 
have specific requirements in the Implementation Guide that must be tested before 
putting the transaction in production. This type of testing only applies to a trading 
partner candidate that conducts transactions for the specific line of business or 
product type.

• Type 7: Implementation Guide-Specific Trading Partners: The Implementation 
Guides contain some HIPAA requirements that are specific to Medicare, Medicaid, 
and Indian Health. Compliance or testing with these payer specific requirements is 
not required from all trading partners. If the trading partner candidate intends to 
exchange transactions with one of these Implementation Guide special players, this 
type of testing is required. When a certification service certifies a trading partner for 
compliance, the certification service must indicate whether these payer specific 
requirements were met during the certification process. Other payers and trading 
partners may have their own specific business requirements. But unless they are 
listed in the HIPAA Implementation Guides, they are not HIPAA requirements. These 
non-HIPAA trading partner specific requirements must be tested as part of the 
business-to-business testing.

Type 1 testing is the validation that is normally performed by BusinessConnect™ Container 
Edition - EDI Protocol powered by Instream.

Types 2 through 7 are extra levels of validation performed by BusinessConnect™ Container 
Edition - EDI Protocol HIPAA Edition powered by Instream.
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HIPAA Validation Error Severity
By default, any validation errors that occur cause a transaction to be rejected. When a 
transaction is rejected, the 997 generated contains the AK5 segment with a Transaction Set 
Acknowledgement Code of 'R' for the transaction. When validating HIPAA transactions, it is 
desirable to be able to control whether a validation error should cause the rejection of the 
entire transaction or not. 

Sometimes we might want the error reported and the transaction rejected. At other times 
we might want to report the error in the 997 but to accept the transaction anyway (for 
example, the generated 997 would have a Transaction Set Acknowledgment Code of 'E' for 
accepted with errors). We might want validation errors ignored altogether or we might 
want only some validation errors ignored.

In conjunction with TIBCO Foresight® HIPAA Validator® Desktop, BusinessConnect Container 
Edition - EDI Protocol HIPAA Edition powered by Instream provides the ability to configure 
the severity of validation errors that occur in HIPAA transactions.

Controlling the severity of validation errors is done through the use of validator profile 
files. For more information about creating and configuring validator profile files to use with 
X12 transactions, see the "Configuring Validation Profile (.apf) Files" section in TIBCO 
BusinessConnect™ Container Edition - EDI Protocol powered by Instream® X12 Configuration. 
The remainder of this section contains information on validator profile files that is specific 
to HIPAA transactions.

Error Severity Types
The following are the segments in the generated 997 acknowledge when a transaction is 
rejected:

   ST~997~0001'
   AK1~HC~000000001'
   AK2~837~000000001'
   AK3~CLM~36~2300~8'
   AK4~11+3~1362~1~AP'
   AK5~R'
   AK9~R~1~1~0'
   SE~9~0001'

The following are the segments in the generated 999 acknowledge when a transaction is 
rejected:
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ST~999~0001'
 AK1~HC~1'
 AK2~837~Transacti~000000000001'
 IK3~NM1~7~2010~8'
 IK4~3~1035~5~NN'
 IK5~R~5'
 AK9~R~1~1~0'
 SE~8~0001'

The AK2 segment identifies the transaction that is rejected. The AK3/IK3 and AK4/IK4 
segments give information about where one or more errors occurred in the transaction. 
The AK5/IK5 segment indicates that the transaction is rejected and contains a transaction 
status code of 'R'. The AK9 segment indicates that the group is rejected, 'R', because there 
was only one transaction in the group and that transaction is rejected. 

If some of the transactions in the group are accepted while others are rejected, the status 
of the group in the AK9 segment would be 'P', which indicates that at least one transaction 
in the group is rejected.

When a transaction is rejected, error information is also sent to the private process on the 
subject AX.BCCE.INSTALLATION.X12.ERROR.VALIDATION. 

This error information contains the transaction ID of the transaction that has validation 
errors and descriptive information about the validation errors similar to the following:

controlNumInfo={^class^="ControlNumberInfo
" ^idx^=1 interchange="000008361" group="1" transaction="000000001"}
errorInfoList={^class^="ConversionEngineInfo" ^idx^=2 ^1^=
{^class^="ConversionEngineInfo" ^idx^=1 errorSeverity="Normal" 
errorCategory="Rejecting" errorMsg="The Previous Claim does not balance. 
Formula used CLM02 (93534) = sum of SV102 (93533)." errorID="30092" 
errorContext="Loop/Group-2440 | Segment-HL" errorDataParent="HL~4~2~2
3~0'" errorSegmentCount=178 errorLoopGroupCount=1}}

Setting different error severity types to validation errors affect the information about the 
validation errors that is contained in 997/999 acknowledgements and the error information 
reported to the private process. It also affects whether the given transaction is converted 
from EDI to XML or from XML to EDI. When a transaction is rejected, no conversion takes 
place.

The following table describes the four levels of severity that can be configured for 
validation errors and their effect on how error information is reported.
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Error
Severity
Type

997/999 Acknowledgement Error Information 
to Private Process

Data
Conversion
Occurs?

Ignore AK5/IK5 segment reports 
transaction status of 'A' for 
accepted. AK3/IK3 and AK4/IK4 
segments are not present.

Does not cause the 
generation of an 
error report to the 
private process.

Yes

Informational AK5/IK5 segment reports 
transaction status of 'A' for 
accepted. AK3/IK3 and AK4/IK4 
segments are not present.

The cause of the 
error is reported in 
the message to the 
private process 
with the error code 
and a description 
of the error.

The error 
description begins 
with Information.

Yes

Warning AK5/IK5 segment reports 
transaction status of 'E' for 
accepted with errors. AK3/IK3 
and AK4/IK4 segments contain 
information about the location 
of the error in the transaction 
as appropriate. 

The cause of the 
error is reported in 
the message to the 
private process 
with the error code 
and a description 
of the error.

The error 
description begins 
with Warning.

Yes

Error AK5/IK5 segment reports 
transaction status of 'R' for 
rejected. AK3/IK3 and AK4/IK4 
segments contain information 
about the location of the error 
in the transaction as 

The cause of the 
error is reported in 
the message to the 
private process 
with the error code 
and a description 

No

Error Severity Types
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Error
Severity
Type

997/999 Acknowledgement Error Information 
to Private Process

Data
Conversion
Occurs?

appropriate. of the error.

Fatal  Similar in behavior 
to the 'Error' type 
but is used for 
system errors.

No

Control Validation Severity Levels
How the validation engine reports the severity of errors is controlled by creating and 
configuring Validator Profile (.apf) files. Either TIBCO EDISIM Validator or TIBCO Foresight® 
HIPAA Validator® Desktop can be used. 

After Validator is started, to create a profile file with your custom settings, perform the 
following steps:

Procedure
 1. Go to Options > Validator Profile.

 2. Select the Filter tab.

The Filter tab has two groups of settings: Severity Level and HIPAA Types, as shown 
in the following figure.
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Figure 3: Validator Options Profile

By default, all of the Severity Levels listed are selected, which means all of these 
categories of errors are included and reported when validating transactions. 

Suppress Severity Level

To cause the validation engine to suppress a particular severity level, perform the following 
steps:

Procedure
 1. Clear the desired severity level checkboxes.

 2. Click Save As.

 3. Specify the location and name to use for the .apf file.

 4. Use the BusinessConnect Operations Editor to upload the .apf file into the 
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configuration for the transaction you want to apply the .apf file during its validation.

Example: For the validation engine, to ignore warning errors during validation of a 
00401/004010X098A1/837 transaction, clear the checkbox next to Warning in the Validator 
Options Profile dialog, save the profile, and then add the .apf file to the configuration of 
the 00401/004010X098A1/837 transaction in the Operations Editor.

Suppress HIPAA Type

The HIPAA Types settings are used to let the validation engine know the types of HIPAA 
errors to include during the validation of transactions. 

By default, all the HIPAA Types are included during validation. clearing a HIPAA type 
indicates that the validation engine should ignore errors of that type during its validation 
of a transaction.

Example: To prevent balancing errors from causing a transaction to fail validation, clear the 
checkbox next to 3-Balancing.

Controlling Severity by Error ID

With validator profile (.apf) files, you can control the severity and HIPAA type of a 
particular error.

After Validator is started, create a profile file with the settings that change the default 
behavior for a particular error ID.

Procedure
 1. Go to Options > Validator Profile.

 2. Select the Messages tab.

The Validator Options Profile dialog appears:
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Figure 4: Validator Options Profile Messages

 3. Select the line with the error for which you want to change the settings.

 4. From the Severity dropdown, select the severity level to apply to the error.

 5. From the HIPAA Type dropdown, select the HIPAA type to apply to the error.

 6. Click Save As.

 7. Specify the location and name to use for the .apf file.

Use the BusinessConnect Container Edition's Operations Editor to upload the .apf file into 
the configuration for the transaction you want to apply the .apf file during its validation.

When using TIBCO Foresight® HIPAA Validator® Desktop to perform design time validation 
of data files, it is also possible to create or modify .apf files to control the validation 
results you see during your design time validation, and then apply the .apf file to your 
BusinessConnect Container Edition configuration.
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Sometimes, it is easier to determine the error ID, for which you need to specify new 
settings when you validate the data file using TIBCO Foresight® HIPAA Validator® Desktop. 
In this case, select the error when it is displayed and specify the settings to use. For 
example, if you used TIBCO Foresight® HIPAA Validator® Desktop to validate a 
004010X098A1 837 Professional data file that contains an error in the format of the zip 
code, at the end of validation you would see something similar to as shown in the 
following figure:

Figure 5: Desktop Validator Diagnostic Message

By selecting the error message in the Diagnostic message pane and then right-click, you 
see the following menu options as shown in the following figure:
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Figure 6: Diagnostic Message Options

The menu options display the error message ID associated with the selected error and also 
you can set the Severity Level and HIPAA Type to associate with that error ID.

Save the .apf file after configuring new settings for an error ID

After you configure new settings for an error ID, save the .apf file created by these actions 
by performing the following steps:

Procedure
 1. Go to Options > Save Profile.

 2. Specify the location and name to use for the .apf file.

 3. Use the BusinessConnect Container Edition's Operations Editor to upload the .apf 
file into the configuration for the transaction you want to apply the .apf file during 
its validation.

De-identifying a File
To protect the private information of individuals, it is sometimes necessary to de-identify 
the patient information in HIPAA transactions. At present, BusinessConnect Container 
Edition - EDI Protocol HIPAA Edition powered by Instream does not provide a tool to de-
identify the patient data in HIPAA transactions. It is recommended to use one of the freely 
available de-identification tools available in the market.
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HIPAA External Code Lists
The X12 specifications identify standard code lists is used to determine the correct values 
for the various data elements of X12 transactions. The HIPAA Implementation Guides or 
Type 3 Technical Reports (TR3s) specify the code list values that should be used for the 
data elements of HIPAA transactions.

The HIPAA Implementation Guides or TR3s can specify various types of code lists. For 
example, a code list could be: 

• a subset of the allowed values specified in the X12 specifications.

or

• a new code list to apply to a data element, which previously had no code list 
applied to it. 

In some cases, the HIPAA Implementation Guides for TR3s specify the exact codes to use 
for a particular code list. In other cases, the HIPAA Implementation Guides for TR3s refer to 
existing sets of codes that are maintained by various organizations throughout the 
government and health care industry.

The code lists, which are maintained by these various organizations are referred to as 
external code lists. Some of the external code lists are freely available (for example, 
external code list #139–Claim Adjustment Reason Codes). Other external code lists must be 
purchased from the organization that maintains the code list (for example, external code 
list #6–D-U-N-S Numbers). For more information about external code list sources, refer to 
Appendix C, External Code Sources, of the HIPAA Implementation Guides or Appendix A, 
External Code Sources, of the HIPAA TR3s. These appendices list the external code lists 
used by the transaction and the organization responsible for maintaining each code list.

BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream 
contains most of the HIPAA external code lists. The HIPAA external code lists are used in 
guidelines, which are provided with BusinessConnect Container Edition - EDI Protocol 
HIPAA Edition powered by Instream, to provide type 5 validation of the HIPAA transactions. 
The external code lists are not contained in the guidelines but are referenced in the 
guidelines through the following external files:

TIBCO_HOME/instream/version_number/bin/fs_hipaa.dat

TIBCO_HOME/instream/version_number/bin/fs_cci.dat

TIBCO_HOME/instream/version_number/bin/fs_occi.dat
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Missing External Code Lists
For some external code lists specified in the HIPAA transaction Implementation Guides or 
TR3s, there is not an associated external code list in the HIPAA transaction guidelines 
supplied with BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by 
Instream. 

Some of the external code lists specified in the HIPAA transaction Implementation Guides 
or TR3s are actually comprised of other external code lists. Another external code list is 
listed in the HIPAA transaction Implementation Guides or TR3s but is not actually used by 
any transaction. These code lists are listed in the following table:

Code 
List

Description

60 Depository Financial Institution (DFI) Identification Number. This code list is 
composed of two other code lists. A qualifier specifies which of the two code 
lists is used when specifying the DFI Identification Number. 

The following two code lists can be used to specify the DFI Identification 
Number: 

• 4        ABA Transit Routing Number

• 91     Canadian Bank Branch and Institution Number

77 X12 Directories. This external code list is not used by any HIPAA transaction. It 
is used in 997 Functional Acknowledgements.

94 International Organization for Standardization (Date and Time). This code list 
does not contain actual values, but specifies the time format to use. The time 
zone codes are included as an internal code list based on X12 standards.

158 Health Care Financing Administration (HCFA). This code list is used in the 
Interchange header for the 820 transaction. 

The EDI Conversion Engine does not perform data validation against external 
code lists for the envelope segments (interchange and group) of the EDI data. It 
is the responsibility of the user to make sure that the information they 
configure for the interchange and group headers is correct.

External Code Lists Without Codelists
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External Code Effective Dates
When a new revision of an external code list is released, the external code list file 
associated with the newly released external code list revision is updated to reflect any new 
codes or modifications to existing codes. For new codes, if an effective date is specified, 
that date is used as the effective start date for the new code. 

The effective date for a code is used to determine whether the code is valid for use by 
HIPAA transactions. If a code used in a HIPAA transaction is found to be outside of the 
code's effective date range, a validation error occurs. The date used in the HIPAA 
transaction for comparing against a code's effective date is determined as follows: 

• Transaction Date: For non-medical code lists, the effective date of a code is 
compared to the transaction date. 

• Date of Service: For medical code lists, the effective date of the code is compared to 
the date of service specified in the transaction.

Update Frequency
Each HIPAA external code list has its own update frequency. Some external code lists are 
updated yearly, others are updated quarterly, and some are updated daily. Each release of 
BusinessConnect™ Container Edition - EDI Protocol HIPAA Edition powered by Instream 
contains the latest updates to the external code lists.

If you require more timely versions of external code lists, you can obtain external code list 
updates by contacting TIBCO Support. 

You can also create and register external code list updates as a User External Code List. For 
more information, see User External Code Lists.

User External Code Lists
With BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream, 
you can change or add to existing code tables, and add completely new code tables to use 
for validation. Using this feature, you can:

• Temporarily add an invalid code to an existing external code list until your trading 
partners fix their use of the invalid code.
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• Augment an external code list and add a custom code that is not normally part of 
the code list.

• Add new codes that have been released but have not yet been incorporated into 
BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by 
Instream.

• Override the settings for existing codes.

By default, BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by 
Instream searches for user external code lists in the file:

TIBCO_HOME/instream/version_number/bin/SampleUserTable.txt

After installation, this file is empty and has a length of zero (0). The following sections 
explain how to edit this file to customize the use of external codes during validation.

For more information about managing custom external codes and code lists, see the 
document Changing Desktop and Instream Code Tables in the following file of your TIBCO 
Foresight® HIPAA Validator® Desktop installation: HIPAA Validator 
Home/Doc/ExtendingCodeTables.pdf

This document also contains the current list of code table names.

Adding External Codes

To add your own custom codes to be used during validation, edit the file 
SampleUserTable.txt and add your custom codes by adding lines to the file using the 
following format:

^USER<code table name>

<code>|<start date>|<end date>|<code description>

The start date and end date must be in the format yyyymmdd. If left blank, use of the 
specified code is always allowed. 

Example: To add a custom ZIP code that can be used regardless of transaction date, add 
the following line to the SampleUserTable.txt file:

^USERZip

99999|||Special zip code with no start or end date



TIBCO BusinessConnect™ Container Edition - EDI Protocol HIPAA Edition powered by Instream® Configuration

24 | Introduction to HIPAA Protocol

Deleting External Codes

To delete an external code from an existing code table, edit the file SampleUserTable.txt 
and add entries that specify the codes to be deleted using the following format:

^USER<code table name>

<code>|del|<end date>|<code description>

Specifying a code to be deleted uses the same format as is used for specifying a code to be 
added except that 'del' is specified as the <start date>. When deleting codes, anything 
entered for the <end date> and <code description> are ignored.

Example: To indicate that the use of zip code 94304 should be invalid, add the following 
lines to the ELCTable.txt file:

^USERZip

94304|del||

Disabling an External Code List

With BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream, 
you can disable the use of an entire code list during validation.

To disable an entire code list, enter the following in the SampleUserTable.txt file:

^<code table name> %DISABLE%

Example: To disable the use of Taxonomy Codes, enter the following in the 
SampleUserTable.txt file:

^TaxonomyCodes %DISABLE%
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HIPAA Transaction Configuration
This section describes how HIPAA transactions are configured in the BusinessConnect 
Container Edition’s Operations Editor.

Overview
To exchange HIPAA transactions using BusinessConnect Container Edition - EDI Protocol 
HIPAA Edition powered by Instream, you must configure a transaction in the Operations 
Editor to associate with each transaction to be exchanged. For more information about this 
process, see the "Operations Editor" section in the document TIBCO BusinessConnect™ 
Container Edition Trading Partner Management.

Since HIPAA transactions are specialized versions of X12 transactions, you should also 
review the X12 specific information for configuring operations in Managing X12 
Interchanges, Functional Groups, and Transactions, and Transactions in the TIBCO 
BusinessConnect™ Container Edition - EDI Protocol powered by Instream® X12 Configuration.

After you understand how to configure X12 transactions, read the sections in this manual 
that provide information specific to the configuration of HIPAA X12 transactions.

Transaction Configuration Files
To configure a HIPAA transaction in the Operations Editor, the following files are needed 
for each transaction:

• HIPAA Transaction Guideline

• HIPAA Transaction Schema

• HIPAA Transaction Map File for EDI to XML or EDI to Text Conversion

• HIPAA Transaction Map File for XML to EDI Conversion

The HIPAA transaction guidelines contain rules that are used to validate HIPAA X12 
transactions according to the HIPAA Implementation Guides (IGs) or Type 3 Technical 
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Reports (TR3s). The HIPAA transaction guidelines provided with BusinessConnect Container 
Edition - EDI Protocol HIPAA Edition powered by Instream are located in multiple locations: 

 l BCCE-1.3.0_Home/images/services/cms/bcce-cms/config and BCCE-1.3.0_
Home/images/services/is/bcce-is/config

 l Fsrest mount path

 l bcce-edihipaa-1.0.0_InstallerFolder>/samples/sampleDocs/guidelines

The HIPAA transaction schemas contain the definition of the XML that can be used by the 
backend process for handling HIPAA transaction data. The schemas associated with the 
HIPAA transaction guidelines provided with BusinessConnect Container Edition - EDI 
Protocol HIPAA Edition powered by Instream are in the directory: bcce-edihipaa-1.0.0_
InstallerFolder>/samples/sampleDocs/schemas

The HIPAA transaction map files are used by the EDI conversion engine to convert HIPAA 
transaction EDI data into XML and the reverse. The HIPAA transaction map files can also be 
used to convert HIPAA transaction EDI data into textual data.

The map files associated with the HIPAA transaction schemas provided with 
BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream are 
in the directory: bcce-edihipaa-1.0.0_InstallerFolder>/samples/sampleDocs/maps.

The map files, which contain the mapping for converting from XML to EDI data have file 
names of the form schema_name_XE.map. The map files used for converting inbound EDI 
data into XML data have file names of the form schema_name_EX.map.

Notice that the names of the HIPAA transaction schemas and maps files are similar to each 
other but they are not similar to the names of the HIPAA transaction guidelines. This is 
because the HIPAA transaction schemas and maps files are created using TIBCO EDISIM 
Standards Editor, which cannot read the HIPAA transaction guidelines because the rules in 
the guidelines are encrypted. So to create the HIPAA transaction schemas and maps files, 
you must use the unencrypted guideline from TIBCO EDISIM, which only contains level 1 
and 2 syntax checks but not the level 3 and above HIPAA validation rules.

The following table lists the TIBCO EDISIM guideline used to generate the schemas and 
map files for each HIPAA transaction.
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HIPAA Transaction HIPAA Guideline EDISIM Guideline

00307/003070X070A1/277 PDSA3070277UX070A1.std 277-X070A1

00401/004010X092A1/270 PDSA270.std 270AA120

00401/004010X092A1/271 PDSA271.std 271AA120

00401/004010X093A1/276 PDSA276 .std 276AA120

00401/004010X093A1/277 PDSA277.std 277AA120

00401/004010X094A1/278 (RQ) PDA278RQ.std 278AREQ

00401/004010X094A1/278 (RSP) PDA278RP.std 278ARES

00401/004010X061A1/820 PDSA820.std 820AA120

00401/004010X095A1/834 PDSA834.std 834AA120

00401/004010X096A1/837 (I) PDSA837I.std 837AQ320

00401/004010X097A1/837 (D) PDSA837D.std 837AQ220

00401/004010X098A1/837 (P) PDSA837P.std 837AQ120

00404/004040X167/277 PDSA4040277UX167.std 277-X167

00405/004050X150/277 PDSA4050277X150.std 277-X150

00405/004050X151/275 PDSA4050275X151.std 275-X151

00405/004050X166/824 PDSA4050824X166.std 824-X166

00501/005010X279A1/270 PDSA5010270X279.std 270-X279

00501/005010X279A1/271 PDSA5010271X279.std 271-X279

TIBCO EDISIM Guidelines
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HIPAA Transaction HIPAA Guideline EDISIM Guideline

00501/005010X212/276 PDSA5010276X212.std 276-X212

00501/005010X212/277 PDSA5010277X212.std 277-X212

00501/005010X217/278 (RQ) PDSA5010278X217Q.std 278X217Q

00501/005010X217/278 (RSP) PDSA5010278X217R.std 278X217

00501/005010X218/820 PDSA5010820.std 820-X218

00501/005010X220A1/834 PDSA5010834.std 834-X220

00501/005010X221A1/835 PDSA5010835.std 835-X221

00501/005010X222A1/837 (P) PDSA5010837P.std 837-X222

00501/005010X223A2/837 (I) PDSA5010837I.std 837-X223

00501/005010X224A2/837 (D) PDSA5010837D.std 837-X224

00501/005010X214/277 PDSA5010277CAX214.std 277CA-X214

00501/005010X186A1/824 PDSA5010824X186.std 824-X186

00501/005010X210/275 PDSA5010275X210.std 275-X210

00501/005010X213/277 PDSA5010277X213.std 277-X213

HIPAA Example Interfaces
The example interfaces provided with BusinessConnect Container Edition - EDI Protocol 
HIPAA Edition powered by Instream demonstrate how to configure the HIPAA transactions. 
The following example interfaces are in the directory: bcce-edihipaa-1.0.0_
InstallerFolder/samples/interfaces

• HIPAA-00401.csx - example interface for version 4010 HIPAA transactions with 
Addenda updates.
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• HIPAA-00501.csx - example interface for version 5010 HIPAA transactions

• HIPAA-Ack-00307-277.csx - unsolicited 277 acknowledgement example

• HIPAA-Ack-00404-277.csx - 277 claim acknowledgement example

• HIPAA-Ack-00501-277.csx - 277 claim acknowledgement example

• HIPAA-Ack-00405-824.csx - 824 Application Advice acknowledgement example

• HIPAA-Ack-00501-824.csx - 824 Application Advice acknowledgement example

• HIPAA-HL7-00405-275-277.csx - HL7 claims attachment example

• HIPAA-HL7-00501-275-277.csx - version 5010 HL7 claims attachment example

• HIPAA-RT-00401-270-271.csx - synchronous request/reply example

• HIPAA-RT-00401-276-277.csx - synchronous request/reply example

• HIPAA-RT-00501-270-271.csx - version 5010 synchronous request/reply example

• HIPAA-RT-00501-276-277.csx - version 5010 synchronous request/reply example

The guidelines used in the example interfaces are in the directory: BC_
HOME\protocols\tibedi\samples\sampleDocs\guidelines

The guidelines used in the example interfaces are available in multiple locations:

 l BCCE-1.3.0_Home/images/services/cms/bcce-cms/config and BCCE-1.3.0_
Home/images/services/is/bcce-is/config

 l Fsrest mount path

 l bcce-edihipaa-1.0.0_InstallerFolder/samples/sampleDocs/guidelines

Note: The unsolicited 277 transaction, 277 claim acknowledgement, and 824 
application advice are not mandated by HIPAA. Customers should verify that 
their trading partners support the unsolicited 277, 277 claim acknowledgement, 
or 824 application advice acknowledgement before using them. The same is true 
of the 275/277 transactions used for HL7 claims attachments.

The EDI data files and XML files required to run the example interfaces are in the directory: 
bcce-edihipaa-1.0.0_InstallerFolder/samples/sampleDocs/datafiles

The data in the sample EDI data files show the use of various elements of the HIPAA 
transactions. The sample EDI data files do not contain real data.
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HIPAA Transaction Guidelines
All the HIPAA guidelines provided with BusinessConnect Container Edition - EDI Protocol 
HIPAA Edition powered by Instream are located as follows:

 l BCCE-<version>_Home/images/services/cms/bcce-cms/config and BCCE-
<version>_Home/images/services/is/bcce-is/config

 l Fsrest mount path

 l bcce-edihipaa-1.0.0_InstallerFolder/samples/sampleDocs/guidelines

Example: Version 5010 guidelines are in the directory: bcce-edihipaa-1.0.0_
InstallerFolder/samples/sampleDocs/datafiles/5010_txns

The following table lists the HIPAA transactions and their associated guidelines:

HIPAA Transaction HIPAA Guideline

00307/003070X070A1/277 PDSA3070277UX070A1.std

00401/004010X092A1/270 PDSA270-B.std   (batch)

00401/004010X092A1/270R PDSA270-RT.std (real-time)

00401/004010X092A1/271 PDSA271.std 

00401/004010X093A1/276 PDSA276-B.std   (batch)

00401/004010X093A1/276R PDSA276-RT.std (real-time) 

00401/004010X093A1/277 PDSA277.std

00401/004010X094A1/278 (RQ) PDA278RQ.std 

00401/004010X094A1/278 (RSP) PDA278RP.std

00401/004010X061A1/820 PDSA820.std 

00401/004010X095A1/834 PDSA834.std 

HIPAA Transactions Guidelines



TIBCO BusinessConnect™ Container Edition - EDI Protocol HIPAA Edition powered by Instream® Configuration

31 | HIPAA Transaction Configuration

HIPAA Transaction HIPAA Guideline

00401/004010X096A1/837 (I) PDSA837I.std 

00401/004010X097A1/837 (D) PDSA837D.std 

00401/004010X098A1/837 (P) PDSA837P.std 

00404/004040X167/277 PDSA4040277UX167.std 

00405/004050X150/277 PDSA4050277X150.std 

00405/004050X151/275 PDSA4050275X151.std 

00405/004050X166/824 PDSA4050824X166.std  

00501/005010X279A1/270 PDSA5010270X279-B.std (batch)

00501/005010X279A1/270R PDSA5010270X279-RT.std (real-time)

00501/005010X279A1/271 PDSA5010271X279.std 

00501/005010X212/276 PDSA5010276X212-B.std (batch)

00501/005010X212/276R PDSA5010276X212-RT.std (real-time)

00501/005010X212/277 PDSA5010277X212.std 

00501/005010X217/278 (RQ) PDSA5010278X217Q.std

00501/005010X217/278 (RSP) PDSA5010278X217R.std

00501/005010X218/820 PDSA5010820.std 

00501/005010X220A1/834 PDSA5010834.std 

00501/005010X221A1/835 PDSA5010835.std 

00501/005010X222A1/837   (P) PDSA5010837P.std 
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HIPAA Transaction HIPAA Guideline

00501/005010X223A2/837 (I) PDSA5010837I.std

00501/005010X224A2/837 (D) PDSA5010837D.std 

00501/005010X214/277 PDSA5010277CAX214.std 

00501/005010X186A1/824 PDSA5010824X186.std 

00501/005010X210/275 PDSA5010275X210.std 

00501/005010X213/277 PDSA5010277X213.std 

Guidelines that are designated as real-time transactions have limits applied as follows:

270 Transaction - number of patients limited to 1

276 Transaction - number of claims limited to 1

Guidelines that are designated as batch transactions have limits applied as follows:

270 Transaction - number of patients limited to 99

276 Transaction - number of claims limited to 99

Simplification of HIPAA Guideline Configuration
The HIPAA transactions are standard, therefore the same transaction guidelines are used 
for all trading partners unless you need to work around a situation in which one of your 
trading partners cannot yet send or receive HIPAA compliant transactions. 

To facilitate the configuration of HIPAA transactions, it is not necessary to upload the .std 
files for the guidelines listed in HIPAA Transactions Guidelines.

By not uploading the guidelines, the size of your repository is reduced. If you have created 
transaction bindings for any of your trading partner configurations, the guidelines are not 
exported with the trading partner configuration unless you have overridden the guideline. 
Therefore, not uploading the HIPAA transaction guidelines can  reduce the size of your 
trading partner configuration exports.
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Note: Whenever a new version of BusinessConnect Container Edition - EDI 
Protocol HIPAA Edition powered by Instream is installed, any changes to the 
HIPAA transaction guidelines, contained in the new version, takes effect 
immediately except for those guidelines, which you have uploaded into your 
repository. Guidelines that are uploaded into your repository must be manually 
replaced with the new versions of the guidelines.

HIPAA Transaction Configuration
HIPAA transactions are specialized versions of X12 transactions and are, therefore, 
configured in the same way. Using the BusinessConnect Container Edition's Operations 
Editor, you can:

 l Add an Interchange Version

 l Add a Group Version to an Interchange Version

 l Add a Transaction to a Group Version

For more information about configuring the X12 transactions, see Managing X12 
Interchanges, Functional Groups, and Transactions, in the TIBCO BusinessConnect™ 
Container Edition - EDI Protocol powered by Instream® X12 Configuration.

Configuring Acknowledgements
In addition to 997 Functional Acknowledgements, 999 Implementation Acknowledgements, 
and TA1 Interchange Acknowledgement Segments, the following business application 
acknowledgements can be automatically generated for HIPAA transactions received from 
your trading partners:

• Application advice (824)

• Unsolicited Health Care Claim Status Notification (277U)

• Health Care Claim Acknowledgement (277CA)

The 824, 277U, and 277CA acknowledgements are treated as regular transactions and 
acknowledgements are returned for them just as they would be returned for a normal 
HIPAA transaction.
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Example: If the system is configured to return 997s and TA1s, then a 997 and TA1 is 
returned when the 824, 277U or 277CA acknowledgement is received.

The 824, 277U, and 277CA acknowledgements are not supported for use in synchronous 
request/response HIPAA transactions. For more information on configuring 999 
Implementation Acknowledgements, see Configuring 999 Implementation 
Acknowledgements. 

Configuring 824 Application Advice 
Acknowledgements
The 824 Application Advice reports the results of an application system's data content edits 
on a transaction set. The 824 Application Advice can report on validation errors that are 
beyond the syntax errors that are normally reported by the 997 or it can report the receipt 
of a transaction that passed validation without any errors. BusinessConnect Container 
Edition - EDI Protocol HIPAA Edition powered by Instream supports the following versions 
of the 824 Application Advice:

• 4050X166 generated for 4010 HIPAA transactions

• 5010X186 generated for 5010 HIPAA transactions

BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream can 
be configured to automatically generate the 824 Application Advice for HIPAA transactions. 
The 824 Application Advice contains information on the validation results when a 
transaction is validated against the validation rules contained in the HIPAA Implementation 
Guides or Type 3 Technical Reports (TR3')s. For more information on configuring 
BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream to 
automatically generate the 824 Application Advice for a trading partner, see HIPAA 
Acknowledgement Properties.

To use the 824 Application Advice, you must also configure the transaction properties in 
the Operations Editor. Example interfaces containing the configurations for the supported 
versions of the 824 are in the directory: bcce-edihipaa-1.0.0_
InstallerFolder/samples/interfaces.

The example interfaces are named as follows: HIPAA-Ack-<interchange version>-824.csx

To explain how to configure the 824 Application Advice, the example interface HIPAA-Ack-
00405-824.csx is used. Importing this interface in the Operations Editor results in the 
following:
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• 00405 interchange version

• 004050X166 group version

• 824 transaction set

After this interface is imported and your trading partner is configured for automatic 
generation of this version of the 824 Application Advice, BusinessConnect Container Edition 
- EDI Protocol HIPAA Edition powered by Instream  automatically generates this version of 
the 824 Application Advice whenever a 4010 HIPAA transaction is validated.

You could also manually configure the 824 Application Advice in the Operations Editor just 
as you would configure any other X12 interchange, group and transaction set. However, for 
the 824 Application Advice, it is not necessary to upload the guidelines to use for 
validation. BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by 
Instream knows which guidelines should be used when the interchange, group and 
transaction are configured as follows:

• 00405 Interchange Version

• 00501 Interchange Version

• 004050X166 Group Version

• 005010X186A1 Group Version

• 824 Transaction Set: leave transaction guideline empty

When configured as above, the following guidelines are used:

• 004050X166_824 Transaction: PDSA4050824X166.std

• 005010X186A1_824 Transaction: PDSA5010824X186.std

These guidelines are in the directory: bcce-edihipaa-1.0.0_
InstallerFolder/samples/sampleDocs/guidelines

Configuring 277U Unsolicited Health Care Claim 
Status Notifications 
The 277U unsolicited health care claim status notification reports the results of an 
application system’s data content edits on the claims in a HIPAA version 4010 837 
transaction set. The example interface HIPAA-Ack-00307-277.csx contains the 
configuration for this acknowledgement. This interface is in the directory: bcce-edihipaa-
1.0.0_InstallerFolder/samples/interfaces
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Importing this interface in the Operations Editor results in the following:

• 00307 interchange version 

• 003070X070A1 group version 

• 277 transaction set 

You could also manually configure the 277U acknowledgement in the Operations Editor 
just as you would configure any other X12 interchange, group and transaction set. 
However, for the 277U acknowledgement, it is not necessary to upload the guidelines to 
use for validation. BusinessConnect Container Edition - EDI Protocol HIPAA Edition 
powered by Instream knows which guidelines should be used when the interchange, group 
and transaction are configured as follows: 

• 00307 Interchange Version 

• 003070X070A1 Group Version 

• 277 Transaction Set: leave transaction guideline empty 

When configured as above, the following guideline is used: 

• 277 Transaction Set: PDSA3070277UX070A1.std 

The guidelines used in the example interfaces are available in multiple locations:

 l BCCE-<version>_Home/images/services/cms/bcce-cms/config and BCCE-1.3.0_
Home/images/services/is/bcce-is/config

 l Fsrest mount path

 l bcce-edihipaa-1.0.0_InstallerFolder/samples/sampleDocs/guidelines

Configuring 277 Claim Acknowledgement
The 277 Claim Acknowledgement has replaced usage of the 277U Unsolicited Health Care 
Claim Status Notification. The 277 Claim Acknowledgement reports the results of an 
application system's data content edits on the claims in a HIPAA 837 transaction.

BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream 
supports two versions of the 277 Claim Acknowledgement:

 l 5010X214

 l 4040X167
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Version 5010X214 277 Claim Acknowledgements can be generated for version 5010 HIPAA 
837 transactions only. 

Version 4040X167 277 Claim Acknowledgements can only be generated for version 4010A1 
HIPAA 837 transactions.

BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream can 
be configured to automatically generate 277 Claim Acknowledgements for the claims inside 
a HIPAA 837 transaction. Generation of both 277 Claim Acknowledgements and 277U 
Unsolicited Health Care Claim Status Notifications cannot be done.

The 277 Claim Acknowledgement contains information on the validation results when a 
claim is validated against the validation rules contained in the HIPAA Implementation 
Guides or Type 3 Technical Reports (TR3')s. For more information on configuring 
BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream to 
automatically generate 277 Claim Acknowledgements for a trading partner, see HIPAA 
Acknowledgement Properties.

To use the 277 Claim Acknowledgement, you must also configure the transaction 
properties in the Operations Editor. Example interfaces containing the configurations for 
the supported versions of the 277 Claim Acknowledgement are in the directory: bcce-
edihipaa-1.0.0_InstallerFolder/samples/interfaces.

The example interfaces are named HIPAA-Ack-interchange version -277.csx.

Configuring 999 Implementation 
Acknowledgements
BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream 
supports the automatic generation of version 005010X231A1 999 Implementation 
Acknowledgements for HIPAA version 5010 transactions.

For more information about configuring BusinessConnect Container Edition - EDI Protocol 
HIPAA Edition powered by Instream to generate version 005010X231A1 999 Implementation 
Acknowledgements in response to HIPAA 5010 transactions, see HIPAA Acknowledgement 
Properties.

For more information about Non-HIPAA 999 Implementation Acknowledgements, see the 
“Configuring Acknowledgements” section in TIBCO BusinessConnect™ Container Edition - EDI 
Protocol powered by Instream® X12 Configuration.
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Setting Up Trading Hosts and Partners
This section describes how to set up trading hosts and partners in BusinessConnect 
Container Edition - EDI Protocol HIPAA Edition powered by Instream. Since HIPAA is a 
specialized version of X12, the configuration for Trading Hosts uses the X12 protocol.

Set Up a Host
To configure a trading host for BusinessConnect Container Edition - EDI Protocol HIPAA 
Edition powered by Instream, follow the instructions given  in the TIBCO BusinessConnect™ 
Container Edition - EDI Protocol powered by Instream® X12 Configuration guide.

Set Up a Partner
To configure a trading partner for BusinessConnect Container Edition - EDI Protocol HIPAA 
Edition powered by Instream, follow the instructions given in the TIBCO BusinessConnect™ 
Container Edition - EDI Protocol powered by Instream® X12 Configuration guide.

Configure the partners using the following tabs:

 l General Same as X12

 l Transmission Structure Same as X12

 o Interchange Header

 o Group Header

 o Control Numbers

 o Delimiters

 l Acknowledgements

 o Acknowledgement Same as X12

 o HIPAA Acknowledgement See HIPAA Acknowledgement Properties.
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 l Logging Same as X12

 l Batching Same as X12

 l Transport Same as X12

HIPAA Acknowledgement Properties

Business Application Acknowledgements
The following is a list of the versions of business application acknowledgements that are 
supported by BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by 
Instream:

• 00405/004050X166/824 - generated for 4010 HIPAA transactions

• 00501/005010X186A1/824 - generated for 5010 HIPAA transactions

• 00307/003070X070A1/277 - generated for 4010 HIPAA transactions

• 00404/004040X167/277 - generated for 4010 HIPAA transactions

• 00501/005010X214/277 - generated for 5010 HIPAA transactions

BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream can 
automatically generate the following business application acknowledgements:

• Application advice (824)

• Unsolicited Health Care Claim Status Notification (277U)

• Health Care Claim Acknowledgement (277CA)

The 824 application advice reports the results of an application system's data content edits 
on a transaction set. The results of editing transaction sets can be reported at the 
functional group and transaction set level, in either coded or free-form format. 

The 824 is designed to report the following for a transaction set:

• Acceptance

• Rejection

• Acceptance with change
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The unsolicited health care claim status notification (277U) reports the results of an 
application system's data content edits on the claims in a transaction set. 

The 277 Claim Acknowledgement (277CA) has replaced the usage of the 277U Unsolicited 
Health Care Claim Status Notification. The 277 Claim Acknowledgement reports the results 
of an application system's data content edits on the claims in a HIPAA 837 transaction.

Use the HIPAA Acknowledgement tab to specify settings to use in composing these 
business application acknowledgements for documents sent by this trading partner. These 
settings take effect only if transaction level acknowledgements have been enabled in the 
Acknowledgement tab. 

The 997 or 999 is generated, when the 824 application advice acknowledgements are also 
generated, the results contain the X12 and HIPAA syntax validation edits for the 
transaction. 

999 Acknowledgements

In accordance with the 5010 transaction TR3s, BusinessConnect Container Edition - EDI 
Protocol HIPAA Edition powered by Instream can be configured to generate version 
005010X231A1 999s for all HIPAA 5010 transactions.

Use the HIPAA Acknowledgement tab to enable the option for generating version 
005010X231A1 999s. This setting overrides any other 997 or 999 acknowledgement 
generation settings for 00501 interchanges, which contain HIPAA 5010 transactions.

See the following table for details.

Field Description

824 Application 
Advice Creation

Defines when 824 acknowledgements are created for this partner by 
the host. The possible acknowledgement creation options are:

• None   No acknowledgement is created (default).

• Always   The acknowledgement is created whether there are 
validation errors to be reported or not. The acknowledgement  
contains all validation edit info other than that which is related 
to syntax checking for X12 and HIPAA. 

• Only on Errors   The acknowledgement is  created only if there 

HIPAA Acknowledgement Fields
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Field Description

are errors in validation that are not related to X12 syntax or 
HIPAA syntax.

824 Application 
Advice Version

Select the version of the 824 Application Advice that should be 
generated:

• 004050X166    This version of 824 application advice is 
generated only for version 4010 HIPAA transactions (default)

• 005010X186   This version of 824 application advice is 
generated only for version 5010 HIPAA transactions.

• 004050X166 & 005010X186    Generate 824 application advice 
for both version 4010 and 5010 HIPAA transactions.

277 Health Care 
Notification 
Creation

Defines when a 277U or 277CA acknowledgement is created for this 
partner by the host. 277U or 277CA acknowledgements are only 
created for 837 transactions.

The possible acknowledgement creation options are:

• None   No acknowledgement is created (default).

• Always   The acknowledgement is created whether there are 
validation errors to be reported or not. The acknowledgement  
contains all validation edit info including that which is related 
to syntax checking for X12 and HIPAA.

277 Health Care 
Notification 
Version

Select the version of the 277U or 277CA that should be generated:

• 003070X070A1 - Unsolicited Claim Status. A 277U is generated 
only for version 4010 HIPAA transactions. (Default)

• 004040X167 - Claim Acknowledgement. A 277CA is generated 
only for version 4010 HIPAA transactions.

• 005010X214 - Claim Acknowledgement. A 277CA is generated 
only for version 5010 HIPAA transactions.

• 004040X167 & 005010X214 - Claim Acknowledgement. A 277C 
is generated for both version 4010 and 5010 HIPAA transactions.

• 003070X070A1 & 005010X214 - Claim Acknowledgement. A 
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Field Description

277U is generated for 4010 HIPAA transactions and a 277CA is 
generated for 5010 HIPAA transactions.

005010X231A1 
999 Ack Creation

 

Enable generation of version 005010X231A1 999 acknowledgements for 
HIPAA 5010 transactions.

• Off - 997 and 999 acknowledgement settings from the 
Acknowledgement tab applied to all transactions.

• 5010 HIPAA Transactions - Version 005010X231A1 999s is 
generated for 00501 interchanges, which contain HIPAA 5010 
transactions. The 'Inbound Ack Creation Option' setting, from 
the Acknowledgement tab, is still applied (for example, 
Interchange, Group, and Txn).

Loading HIPAA Guidelines

Load Guidelines and XSDs
BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream 
installation package contains a sample configuration file for this tutorial.

To import the configuration file into the BusinessConnect Container Edition's Operations 
Editor, perform the following steps:

Procedure
 1. On the B2B Administration tile, click Operations Editor.

 2. Click the Import icon .

 3. In the Import Operations dialog, click Upload file.

 4. Go to the directory bcce-edihipaa-1.0.0_InstallerFolder/samples/interfaces 
and select the HIPAA-RT-00401-270-271.csx file.

 5. Click Open.
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 6. Click Import.

Review Guidelines
To review the guideline loaded for the 270 Eligibility, Coverage or Benefit Inquiry 
transaction, perform the following steps:

Procedure
 1. On the B2B Administration tile, click Operations Editor.

 2. Click the X12 protocol.

 3. Click the  icon to display all X12 operations.

Figure 7: Edit Operations

 4. Click the 270 link.

 5. Click the Guideline tab.

 6. Notice that there is not a guideline specified for the Request, the Acceptance 
Response, or the Rejection Ack. Only the GS01 Functional Identifier Code has to be 
specified for each of these items.

Guideline files do not have to be specified for HIPAA transactions because 
BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream 
has default guidelines that provide HIPAA-compliant validation. For HIPAA 
transactions, it uses the default guideline if the Transaction Guideline field is left 
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empty and the interchange and group are properly named.

 7. Click Save.
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HIPAA Transactions Tutorial
This section gives an overview of how to use BusinessConnect Container Edition - EDI 
Protocol HIPAA Edition powered by Instream to exchange real-time transactions. 

In this tutorial, you configure trading partner information, configure a private process to 
communicate with BusinessConnect Container Edition - EDI Protocol HIPAA Edition 
powered by Instream, and run the tutorial.

Overview
In this tutorial, you use TIBCO ActiveMatrix BusinessWorks™ and BusinessConnect 
Container Edition - EDI Protocol HIPAA Edition powered by Instream running on the host 
machine to send a HIPAA 270 Eligibility, Coverage or Benefit Inquiry transaction to the 
trading partner machine running BusinessConnect Container Edition - EDI Protocol HIPAA 
Edition powered by Instream. 

A simple private process on the receiving machine is configured to send the HIPAA 271 
Eligibility, Coverage or Benefit Information transaction through BusinessConnect Container 
Edition - EDI Protocol HIPAA Edition powered by Instream in response to the 270 
transaction. The transaction set identifier information is as follows:

• The initiator machine:

— Transaction set - 270

— Group version - 4010X092A1

— Interchange version - 00401

• The responder machine:

— Transaction set - 271

— Group version - 4010X092A1

— Interchange version - 00401

As you run the tutorial, the TIBCO software applications perform the following tasks on the 
host machine:



TIBCO BusinessConnect™ Container Edition - EDI Protocol HIPAA Edition powered by Instream® Configuration

46 | HIPAA Transactions Tutorial

 1. TIBCO Business Studio reads the XML file that contains the data for the 270 
transaction.

 2. TIBCO Business Studio parses the XML data and sends the XML data to 
BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by 
Instream.

 3. BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream 
converts the XML data to X12 data.

 4. BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream 
validates the X12 data against the 270 guideline.

 5. The validated X12 data is bundled into an interchange for sending to the trading 
partner.

 6. The software uses HTTP transport to send the interchange to the trading partner.

The TIBCO software applications perform the following tasks on the trading partner 
machine:

 1. BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream 
receives the X12 interchange.

 2. BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream 
validates the X12 data against the 270 transaction guideline.

 3. The software converts validated 270 X12 data to XML data.

 4. The software sends the converted 270 XML data to the private process.

 5. The private process returns statically configured 271 XML data to BusinessConnect 
Container Edition - EDI Protocol HIPAA Edition powered by Instream.

 6. BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream 
takes the 271 XML data that it receives from the private process and converts the 
XML data to X12 data.

 7. BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream 
validates the X12 data against the 271 guideline.

 8. The software bundles the validated 271 data into an interchange.

 9. BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream 
takes the interchange containing the 271 data and returns it as part of the 200 OK 
HTTP response to the original HTTP request.

The following steps occur on the host machine:
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 l BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream 
validates the X12 data against the 271 transaction guideline.

 l The software converts the validated 271 X12 data to XML data.

 l The software sends the converted 271 XML data to the private process.

 l The private process logs data from the 271 response.

The following sections describe how to set up and run the tutorial. The steps required in 
setting up BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by 
Instream to run the tutorial are the same steps that are discussed in the “Managing EDI 
Guidelines” and “Exchanging Documents” topics in the TIBCO BusinessConnect™ Container 
Edition - EDI Protocol powered by Instream® User Guide. 

Tutorial Prerequisites
Before starting the tutorial, ensure that the following TIBCO software packages are 
installed on the host and trading partner machines:

 1. TIBCO BusinessConnect™ Container Edition

For more information on setting up and running TIBCO BusinessConnect™ Container 
Edition, see the TIBCO BusinessConnect™ Container Edition Administration and TIBCO 
BusinessConnect™ Container Edition Trading Partner Management guides.

 2. TIBCO ActiveMatrix BusinessWorks™.

 3. TIBCO ActiveMatrix BusinessWorks™ Plug-in for BusinessConnect™

 4. TIBCO BusinessConnect™ Container Edition - EDI Protocol powered by Instream®

If you are not familiar with the X12 standard, see the "X12 Overview" topic in TIBCO 
BusinessConnect™ Container Edition - EDI Protocol powered by Instream® X12 
Configuration.

Review the "Managing EDI Guidelines" and "Exchanging Documents" topics in the 
TIBCO BusinessConnect™ Container Edition - EDI Protocol powered by Instream® User 
Guide.

 5. TIBCO BusinessConnect™ Container Edition - EDI Protocol HIPAA Edition powered by 
Instream®

If you are not familiar with HIPAA, see Introduction to HIPAA Protocol.
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Note: For the exact versions of these software packages, see the Readme file. 

BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by 
Instream installation package contains all the guidelines needed for this tutorial. 
Therefore it is not required to use EDISIM to create and customize any guidelines 
for the tutorial.

Configuring the Trading Host Machine

Load Guidelines and XSDs
The first step in configuring the trading host machine is to load the guidelines and XSDs. 
For this tutorial, the procedure for loading the guidelines and XSDs is the same on both the 
Trading Host machine and the Trading Partner machine. Use the example interface HIPAA-
RT-00401-270-271.csx on both the Trading Host machine and the Trading Partner 
machine.

Perform the steps provided in Review Guidelines and Load Guidelines and XSDs.

Create the Trading Host on the Host Machine
To create the trading host and set it as the default host, perform the following steps:

Procedure
 1. On the Partner Management tile, click Hosts.

 2. On the Hosts page, click Create Host, which is on the top-right corner of the page.

 3. In the Host Name field, enter Company1.

 4. Click Proceed.

 5. Select the Make this as Default Host checkbox.

 6. Click Done.
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Configure the Host Protocol on the Host Machine

For this tutorial, disable all protocols except for the X12 protocol. The interchange qualifier 
and ID are then configured for the X12 protocol. 

Enable the X12 Protocol

Procedure
 1. Go to Partner Management > Hosts > Company1.

 2. On the Protocols tab, disable all the protocols except X12 by clearing the checkboxes 
of other available protocols.

Set the Interchange Qualifier and ID

Procedure
 1. Go to Partner Management > Hosts > Company1.

 2. Click Edit Configurations next to the X12 checkbox.

 3. Click the Add icon next to the Default Interchange Qualifier ID field.

 4. In the Add New dialog, select 01 from the Domain Type list.

 5. In the ID field, enter 123456789. 

 6. Click Add. 

 7. In the Default Interchange Qualifier ID field, select 01-123456789. 

 8. Click Save.

Create the Trading Partner on the Host Machine
To create the trading partner and enable the X12 protocol, perform the following steps:

Procedure
 1. On the Partner Management tile, click Partners.

 2. On the Partners page, click Create Partner, which is on the top-right corner of the 
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page.

 3. In the Partner Name field, enter Company2.

 4. Click Proceed.

 5. On the Protocols tab, select the X12 checkbox.

 6. Click Done.

Set the Interchange Qualifier and ID

Procedure
 1. Go to Partner Management > Partners > Company2.

 2. Click Edit Configurations next to the X12 checkbox.

 3. Click the Add icon next to the Default Interchange Qualifier ID field.

 4. In the Add New dialog, select 01 from the Domain Type list.

 5. In the ID field, enter 987654321. 

 6. Click Add. 

 7. In the Default Interchange Qualifier ID field, select 01-987654321. 

 8. Click Save. 

Enable Outbound EDI Validation

To enable outbound EDI validation, perform the following steps:

Procedure
 1. Go to Partner Management > Partners > Company2.

 2. Click Edit Configurations next to the X12 checkbox.

 3. On the General tab in the Outbound section, select the Enable EDI Validation 
checkbox. 

Set the Transport

To set the transport, perform the following steps:
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Procedure
 1. Go to Partner Management > Partners > Company2.

 2. Click Edit Configurations next to the X12 checkbox.

 3. Go to the Transport tab.

 4. Click Add Outbound Transport.

 5. In the Add Transport dialog, enter HTTP in the Transport Name field.

 6. From the Transport Type dropdown list, select HTTP.

 7. Click Add.

 8. In the URL field, enter the name of the trading partner’s machine. Example: 
machine1.acme.com:8800/X12.

 9. Click Save.

Configure the Business Agreement on the Host 
Machine

Procedure
 1. On the Partner Management tile, click Business Agreements.

 2. On the Business Agreements page, click Create Agreement, which is on the top-right 
corner of the page.

 3. Select Company1 in the Host field and Company2 in the Partner field. 

 4. Click Proceed.

 5. On the Bind Protocol tab, select the X12 checkbox.

 6. Click Edit Configurations next to the X12 checkbox.

 7. Go to the Transports tab and verify that HTTP is selected in the Primary Transport 
dropdown list in the Outbound transport for Host “Company1” area.

 8. Click Save.
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Configure Private Processes on the Host Machine
BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream 
installation package contains an example TIBCO ActiveMatrix BusinessWorks™ project that 
sends a HIPAA 270 transaction to BusinessConnect Container Edition.

This section contains the following parts:

 l Processes Overview

 l Configuring Private Process in TIBCO Business Studio

Processes Overview

The example HIPAA_RTPatientEligibility project contains the following processes:

• Send 270 RT Request: Reads a file containing the XML data equivalent to the 270 
transaction and sends the XML data to BusinessConnect Container Edition.

• Validation Error Advisory Received: Activated when BusinessConnect Container 
Edition sends out an advisory indicating that there is a validation error on the 
original 270 Transaction. 

Configuring Private Process in TIBCO Business Studio

To configure the private process in TIBCO Business Studio:

• Opening the TIBCO ActiveMatrix BusinessWorks Project

• Configuring Connections to BusinessConnect Container Edition

Opening the TIBCO ActiveMatrix BusinessWorks Project

To open the TIBCO ActiveMatrix BusinessWorks project in TIBCO Business Studio, perform 
the following steps:

Procedure
 1. Start TIBCO Business Studio.

 2. Go to File > Import. 

 3. On the Import page, expand the General folder and select the Existing Studio 
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Projects into Workspace item. Click Next.

 4. Click Browse next to the Select archive file field.

 5. Go to the /bcce-edihipaa-1.0.0/samples/bw/HIPAA_RTPatientEligibility 
directory and select the HIPAA_RTPatientEligibility_for_bw6.zip file.

 6. Click Finish.

After importing the sample, perform the following steps:

 1. Expand Module Descriptors in the Project Explorer view.

 2. Double-click Module Properties.

 3. On the User tab, change the default values of the BCHome and TPName properties 
according to your environment.

Configuring Connections to BusinessConnect Container Edition

To configure connections to BusinessConnect Container Edition on the Initiator computer, 
perform the following steps:

Procedure
 1. In the Project Explorer view, expand Resources and double-click 
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BCConnection.bcResource.

 2. Configure the server information on the Server Access tab.

 a. From the JDBC Driver dropdown list, select the JDBC driver that you use to 
communicate with the BusinessConnect Container Edition configuration store.

 b. In the JDBC URL field, enter the URL for the configuration store.

 c. In the DB User and Password fields, enter the configuration store username 
and password.

 d. Click Apply and Save.

 3. On the Configuration tab, click Update from Configuration Store.

 4. From the Protocol Name dropdown list, select X12.

If you select the Select Operations checkbox, you can select any of the configured or 
imported operations. For this tutorial, select all operations and click OK.

 5. Click Import Selected Business Protocol.

When you import the protocol, BusinessWorks retrieves information from the 
BusinessConnect Container Edition configuration store and puts them in the project 
folder.

 6. Click Save.
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Configuring the Trading Partner Machine 
The following sections describe how to configure BusinessConnect Container Edition - EDI 
Protocol HIPAA Edition powered by Instream on the trading partner machine for running 
this tutorial.

Load Guidelines and XSDs
The first step in configuring the trading partner machine is to load the guidelines and XSDs. 
For this tutorial, the procedure for loading the guidelines and XSDs is the same on both the 
Trading Host machine and the Trading Partner machine. Use the example interface HIPAA-
RT-00401-270-271.csx on both the Trading Host machine and the Trading Partner 
machine.

Perform the steps provided in Review Guidelines and Load Guidelines and XSDs.

Configure the Trading Host on the Trading Partner 
Machine
To configure the trading host on the trading partner machine, create the trading host and 
configure the protocol for the trading host. 
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Create the Trading Host on the Partner Machine

To create the trading host and set it as the default host, perform the following steps:

Procedure
 1. On the Partner Management tile, click Hosts.

 2. On the Hosts page, click Create Host, which is on the top-right corner of the page.

 3. In the Host Name field, enter Company2.

 4. Click Proceed.

 5. Select the Make this as Default Host checkbox.

 6. Click Done.

Configure the Host Protocol on the Partner Machine

For this tutorial, disable all protocols except for the X12 protocol. The interchange qualifier 
and ID are then configured for the X12 protocol. 

Enabling The X12 Protocol

Procedure
 1. Go to Partner Management > Hosts > Company2.

 2. On the Protocols tab, disable all the protocols except X12 by clearing the checkboxes 
of other available protocols.

Setting The Interchange Qualifier and ID 

Procedure
 1. Go to Partner Management > Hosts > Company2.

 2. Click Edit Configurations next to the X12 checkbox.

 3. Click the Add icon next to the Default Interchange Qualifier ID field.

 4. In the Add New dialog, select 01 from the Domain Type list.

 5. In the ID field, enter 987654321. 
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 6. Click Add. 

 7. In the Default Interchange Qualifier ID field, select 01-987654321. 

 8. Click Save.

Configure the Trading Partner on the Trading 
Partner Machine 
To configure the trading partner on the trading partner machine, you need to create the 
trading partner and configure the protocol for the trading partner.

Create the Trading Partner on the Partner Machine

To create the trading partner and enable the X12 protocol, perform the following steps:

Procedure
 1. On the Partner Management tile, click Partners.

 2. On the Partners page, click Create Partner.

 3. In the Partner Name field, enter Company1.

 4. Click Proceed.

 5. On the Protocols tab, select the X12 checkbox.

 6. Click Done.

Set the Interchange Qualifier and ID

Procedure
 1. Go to Partner Management > Partners > Company1.

 2. Click Edit Configurations next to the X12 checkbox.

 3. Click the Add icon next to the Default Interchange Qualifier ID field.

 4. In the Add New dialog, select 01 from the Domain Type list.

 5. In the ID field, enter 123456789. 
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 6. Click Add. 

 7. In the Default Interchange Qualifier ID field, select 01-123456789. 

 8. Click Save. 

Enable Outbound EDI Validation 

To enable outbound EDI validation, perform the following steps:

Procedure
 1. Go to Partner Management > Partners > Company1.

 2. Click Edit Configurations next to the X12 checkbox.

 3. On the General tab in the Outbound section, select the Enable EDI Validation 
checkbox. 

Set the Transport 

To set the transport, perform the following steps:

Procedure
 1. Go to Partner Management > Partners > Company1.

 2. Click Edit Configurations next to the X12 checkbox.

 3. Go to the Transport tab.

 4. Click Add Outbound Transport.

 5. In the Add Transport dialog, enter HTTP in the Transport Name field.

 6. Select HTTP from the Transport Type dropdown list.

 7. Click Add.

 8. In the URL field, enter the name of the trading partner’s machine. Example: 
machine2.vidgets.com:8800/X12.

 9. Click Save.
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Configure the Business Agreement on the Trading 
Partner Machine

Procedure
 1. On the Partner Management tile, click Business Agreements.

 2. On the Business Agreements page, click Create Agreement, which is on the top-right 
corner of the page.

 3. Select Company2 in the Host field and Company1 in the Partner field. 

 4. Click Proceed.

 5. On the Bind Protocol tab, select the X12 checkbox.

 6. Click Edit Configurations next to the X12 checkbox.

 7. Go to the Transports tab and verify that HTTP is selected in the Primary Transport 
dropdown list in the Outbound transport for Host “Company2” area.

 8. Click Save.

Configure the Private Process on the Trading 
Partner Machine
TIBCO BusinessConnect™ Container Edition - EDI Protocol powered by Instream® 
installation package contains a simple program to send response XML to BusinessConnect 
Container Edition. Use this simple program as the private process on the trading partner 
machine and configure it to send the 271 response transaction. 

Running the Tutorial
To run the tutorial, perform the following steps on the trading partner machine:

Procedure
 1. Create a deployment configuration, deploy, and start TIBCO BusinessConnect™ 
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Container Edition.

During the deployment process, the default behavior is to start the deployed service. 
For more information on deployment, see the TIBCO BusinessConnect™ Container 
Edition Installation and Deployment guide.

 2. Open the HIPAA_RTPatientEligibility project and configure the "Receive 270 Sync 
Request" process in TIBCO ActiveMatrix BusinessWorks™ 6.x.

Note: HIPAA_RTPatientEligibility_for_bw6.zip file is in the bcce-
edihipaa-1.0.0/samples/bw/HIPAA_RTPatientEligibility directory.

On the host machine, perform the following steps:

Procedure
 1. Create a deployment configuration, deploy, and start TIBCO BusinessConnect™ 

Container Edition.

 2. Send the HIPAA 270 transaction from TIBCO Business Studio. See Send the HIPAA 270 
Transaction.

 3. Verify the results of sending the message.  See Expected Results and Viewing Logs.

Send the HIPAA 270 Transaction
The Send 270 RT Request process, performs the following tasks:

Procedure
 1. Reads a file containing XML data for a HIPAA 270 transaction.

 2. Parses the 270 XML data.

 3. Constructs a request message containing the 270 XML data and sends it to 
BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by 
Instream.

 4. Waits for a response to the request.

 5. Logs information from the response.

Figure 8: Send 270 RT Request Process
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Run the Tutorial on the Host Machine

To run the tutorial on the host machine, perform the following steps:

 1. In the opened TIBCO Business Studio project, expand the HIPAA_RTPatientEligibility 
folder in the Project Explorer tab, and click the Send_270_RT_Request process.

 2. Click the SendRequest activity, and then click the Input tab to verify the name of the 
trading partner

 3. On the Tester tab, click the dropdown icon next to the BWApplication icon.

 4. Select Run Configuration from the dropdown list.

 5. In the Run Configurations dialog, expand BusinessWorks Application > 
BWApplication.

 6. From the list of the processes displayed, you can select one or multiple items based 
on the type of transaction you want to process. In this tutorial, click the Send_270_
RT_Request message.

 7. Click Apply > Run.

You can see BusinessWorks logs on the Console tab.
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Note: If you want to run the process in debug mode, click the Debug 
BWApplication icon > Debug Configurations and follow the above procedure 
from Step 5.

Expected Results
After the 270 transaction is received by the host BusinessConnect Container Edition - EDI 
Protocol HIPAA Edition powered by Instream, the following events occur:

 1. The host BusinessConnect Container Edition converts the XML data to X12 data.

 2. The host validates the X12 data against the 270 guideline.

 3. The validated X12 data is bundled into an interchange for sending the data to trading 
partner.

 4. The X12 interchange is sent to the trading partner using HTTP.

 5. The trading partner BusinessConnect Container Edition receives the X12 data.

 6. The trading partner validates the X12 data against the 270 guideline.

 7. The trading partner converts the X12 data to XML data.

 8. The trading partner sends the XML data to its private process.

 9. The trading partner’s private process sends 271 XML data as a response to the 
trading partner’s BusinessConnect Container Edition.

 10. The trading partner converts the XML data to X12 data.

 11. The trading partner validates the X12 data against the 271 guideline.

 12. The validated X12 response is bundled into an interchange for sending to the host.

 13. The X12 response interchange is sent to the host as part of the HTTP 200 OK 
response status.

 14. The host validates the X12 response against the 271 guideline.

 15. The host converts the X12 response into XML data.

 16. The host sends the XML data response to its private process.

 17. The host private process logs data from the XML response.
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What you Can Observe

The Send HIPAA 270 Request activity of the Send 270 RT Request process contains the 
output that indicates the 270 transaction is successfully sent to the trading partner.

 l The Map RT Response activity of the Send 270 RT Request process contains the 
output that indicates the 271 response is successfully received from the trading 
partner.

 l The audit logs on the host and trading partner contain entries for each processing 
state that occurred in BusinessConnect Container Edition. See Viewing Logs.
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HIPAA Acknowledgements Tutorial
This section gives an overview of how to use TIBCO BusinessWorks™ with BusinessConnect 
Container Edition - EDI Protocol HIPAA Edition powered by Instream when HIPAA 
acknowledgements are received for a transaction. In this tutorial, you learn how to 
configure the trading partner to respond with the HIPAA acknowledgements and how the 
private process can be structured to receive them. 

Overview
In this tutorial, you use TIBCO BusinessWorks and BusinessConnect Container Edition - EDI 
Protocol HIPAA Edition powered by Instream running on the host machine to send the 
HIPAA 837 Professional transaction to the trading partner machine running 
BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream. 

The receiving machine is configured to return TA1, 997, 824, and 277U acknowledgements.

The transaction set identifier information is as follows:

• The initiator machine:

— Transaction set - 837

— Group version - 4010X098A1

— Interchange version - 00401

• The responder machine:

— Transaction set - 824

— Group version - 4050X166

— Interchange version - 00405

— Transaction set - 277

— Group version - 3070X070A1

— Interchange version - 00307
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As you run the tutorial, the TIBCO software applications perform the following tasks on the 
host machine:

 1. TIBCO Business Studio reads an XML file that contains the data for the 837 
Professional transaction.

 2. TIBCO Business Studio parses the XML and sends the XML data to BusinessConnect 
Container Edition - EDI Protocol HIPAA Edition powered by Instream.

 3. BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream 
converts the XML data to X12 data.

 4. BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream 
validates the X12 data against the 837 Professional guideline. 

 5. The validated X12 data are bundled into an interchange for sending to the trading 
partner.

 6. The software uses HTTP transport to send the interchange to the trading partner.

The TIBCO software applications perform the following tasks on the trading partner 
machine:

 1. BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream 
receives the X12 interchange.

 2. BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream 
validates the X12 data against the 837 Professional guideline.

 3. The software converts the validated 837 Professional X12 data into XML data.

 4. The software sends the converted 837 Professional XML data to the private process.

 5. The software generates TA1, 997, 824, and 277U acknowledgements.

 6. BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream 
sends each acknowledgement to the host machine.

The following steps occur on the host machine:

 1. BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream 
validates each acknowledgement as it is received against the appropriate guideline.

 2. The software converts the validated acknowledgement X12 data to XML data.

 3. The software sends the converted XML data for each acknowledgement to the private 
process.
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 4. The private process receives each acknowledgement and logs the status data from 
each acknowledgement type.

The following sections describe how to set up and run the tutorial. The steps required in 
setting up BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by 
Instream to run the tutorial are:

 l Authoring and Configuring EDI Guidelines

 l Setting Up Trading Partners

 l Creating Private Processes

Prerequisites
Before starting the tutorial, ensure that the following TIBCO software packages are 
installed on the host and trading partner machines:

 1. TIBCO BusinessConnect™ Container Edition

For more information on setting up and running TIBCO BusinessConnect™ Container 
Edition, see the TIBCO BusinessConnect™ Container Edition Administration and TIBCO 
BusinessConnect™ Container Edition Trading Partner Management guides.

 2. TIBCO ActiveMatrix BusinessWorks™ Plug-in for BusinessConnect™

 3. TIBCO BusinessConnect™ Container Edition - EDI Protocol powered by Instream®

If you are not familiar with the X12 standard, see the "X12 Overview" topic in TIBCO 
BusinessConnect™ Container Edition - EDI Protocol powered by Instream® X12 
Configuration.

Review the "Managing EDI Guidelines" and "Exchanging Documents" topics in the 
TIBCO BusinessConnect™ Container Edition - EDI Protocol powered by Instream® User 
Guide.

 4. TIBCO BusinessConnect™ Container Edition - EDI Protocol HIPAA Edition powered by 
Instream®

If you are not familiar with HIPAA, see Introduction to HIPAA Protocol.
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Note: For the exact versions of these software packages, see the Readme file. 

BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by 
Instream installation package contains all the guidelines needed for this tutorial. 
Therefore it is not required to use EDISIM to create and customize any guidelines 
for the tutorial.

Configuring the Trading Host Machine
If you have run HIPAA Transactions Tutorial, you have already configured most of the Host 
and Partner machines. This tutorial uses a different set of HIPAA guidelines that must be 
configured in the Operations Editor. Continue setting up the trading host machine by 
performing the steps in Load Guidelines and XSDs.

If you did not run the previous tutorial, perform the steps described in the following 
sections:

• Create the Trading Host on the Host Machine

• Create the Trading Partner on the Host Machine

• Configure the Business Agreement on the Host Machine

Load Guidelines and XSDs
This section describes how to load the guidelines and XSDs for the HIPAA X12 transactions 
and acknowledgements. BusinessConnect Container Edition - EDI Protocol HIPAA Edition 
powered by Instream installation package contains sample configuration files for this 
tutorial. 

To import the configuration files into the BusinessConnect Container Edition's Operations 
Editor on the trading host machine, perform the following steps:

Procedure
 1. On the B2B Administration tile, click Operations Editor.

 2. Click the Import icon .
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 3. In the Import Operations dialog, click Upload file.

 4. Go to the directory bcce-edihipaa-1.0.0_InstallerFolder/samples/interfaces 
and select the HIPAA-Ack-00307-277.csx file.

 5. Click Open.

 6. Click Import.

 7. Repeat this procedure and import the bcce-edihipaa-1.0.0_
InstallerFolder/samples/interfaces/HIPAA-Ack-00405-824.csx file.

 8. Click Done.

Configure the TIBCO BusinessWorks Private 
Processes on the Host Machine
BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by Instream 
installation package contains an example TIBCO BusinessWorks project that sends a HIPAA 
837 Professional transaction to BusinessConnect Container Edition.

This section contains the following parts:

 l Processes Overview

 l Configuring Private Process in TIBCO Business Studio

Processes Overview

The example HIPAA_Acks project contains the following processes:

• Send HIPAA 837 Request Reads a file containing the XML equivalent of an 837 
Professional transaction and sends the XML data to BusinessConnect Container 
Edition.

• Receive TA1 Interchange Acknowledgement Activated when BusinessConnect 
Container Edition receives a TA1 Interchange Acknowledgement. 

• Receive 997 Functional Acknowledgement Activated when BusinessConnect 
Container Edition receives the 997 Functional Acknowledgement.

• Receive 824 Application Advice Activated when BusinessConnect Container Edition 
receives the 824 HIPAA Acknowledgement.
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• Receive 277U Claim Status Activated when BusinessConnect Container Edition 
receives the 277U HIPAA Acknowledgement.

Configuring Private Process in TIBCO Business Studio

To configure the private process in TIBCO Business Studio, perform the following tasks:

• Opening the TIBCO ActiveMatrix BusinessWorks Project

• Configuring Connections to BusinessConnect Container Edition

Opening the TIBCO ActiveMatrix BusinessWorks Project

To open the TIBCO ActiveMatrix BusinessWorks project in TIBCO Business Studio, perform 
the following steps:

Procedure
 1. Start TIBCO Business Studio.

 2. Go to File > Import. 

 3. On the Import page, expand the General folder and select the Existing Studio 
Projects into Workspace item. Click Next.

 4. Click Browse next to the Select archive file field.

 5. Go to the bcce-edihipaa-1.0.0_InstallerFolder/samples/bw/HIPAA_Acks 
directory.

 6. Click Finish.

After importing the sample, perform the following steps:

 1. Expand Module Descriptors in the Project Explorer view.

 2. Double-click Module Properties.

 3. On the User tab, change the default values of the BCHome and TPName properties 
according to your environment.
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Figure 9: BusinessWorks Project

Configuring Connections to BusinessConnect Container Edition

To configure connections to BusinessConnect Container Edition on the Initiator computer, 
perform the following steps:

Procedure
 1. In the Project Explorer view, expand Resources and double-click 

BCConnection.bcResource.

 2. Configure the server information on the Server Access tab.

 a. From the JDBC Driver dropdown list, select the JDBC driver that you use to 
communicate with the BusinessConnect Container Edition configuration store.

 b. In the JDBC URL field, enter the URL for the configuration store.

 c. In the DB User and Password fields, enter the configuration store username 
and password.

 d. Click Apply and Save.
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Figure 10: BCCE Server Configuration

 3. On the Configuration tab, click Update from Configuration Store.

 4. From the Protocol Name dropdown list, select X12.

If you select the Select Operations checkbox, you can select any of the configured or 
imported operations. For this tutorial, select all operations and click OK.

 5. Click Import Selected Business Protocol.

When you import the protocol, BusinessWorks retrieves information from the 
BusinessConnect Container Edition configuration store and puts them in the project 
folder.

 6. Click Save.

Figure 11: BCCE Connection Configuration
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Configuring The Trading Partner Machine 

Load Guidelines and XSDs
This section describes how to load the guidelines and XSDs for the HIPAA X12 transactions 
and acknowledgements. BusinessConnect Container Edition - EDI Protocol HIPAA Edition 
powered by Instream installation package contains sample configuration files for this 
tutorial. 

To import the configuration files into the Operations Editor on the trading partner 
machine, perform the following steps:

Procedure
 1. On the B2B Administration tile, click Operations Editor.

 2. Click the Import icon .

 3. In the Import Operations dialog, click Upload file.

 4. Go to bcce-edihipaa-1.0.0_InstallerFolder/samples/interfaces/HIPAA-Ack-
00307-277.csx

 5. Click Open.

 6. Click Import.

 7. Repeat this procedure and import the bcce-edihipaa-1.0.0_
InstallerFolder/samples/interfaces/HIPAA-Ack-00405-824.csx file.

 8. Click Done.

Configure the Trading Host on the Trading Partner 
Machine 
If you have run HIPAA Transactions Tutorial, you have already configured the trading host 
on the Trading Partner machine. 

If you did not run the previous tutorial, perform the steps described in the Configure the 
Trading Host on the Trading Partner Machine section.
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Configure the Trading Partner on the Trading 
Partner Machine 
If you have already run the HIPAA Transactions Tutorial, you have partially configured the 
Trading Partner on the Trading Partner machine. In this case, skip to Configure the HIPAA 
Acknowledgements .

If you did not run the previous tutorial, perform the steps described in the following 
sections.

Create the Trading Partner on the Partner Machine

To create the trading partner and enable the X12 protocol, perform the following steps:

Procedure
 1. On the Partner Management tile, click Partners.

 2. On the Partners page, click Create Partner, which is on the top-right corner of the 
page.

 3. In the Partner Name field, enter Company1.

 4. Click Proceed.

 5. On the Protocols tab, select the X12 checkbox.

 6. Click Done.

Set the Interchange Qualifier and ID

Procedure
 1. Go to Partner Management > Partners > Company1.

 2. Click Edit Configurations next to the X12 checkbox.

 3. Click the Add icon next to the Default Interchange Qualifier ID field.

 4. In the Add New dialog, select 01 from the Domain Type list.

 5. In the ID field, enter 123456789. 

 6. Click Add. 
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 7. In the Default Interchange Qualifier ID field, select 01-123456789. 

 8. Click Save. 

Enable Outbound EDI Validation 

To enable outbound EDI validation, perform the following steps:

Procedure
 1. Go to Partner Management > Partners > Company1.

 2. Click Edit Configurations next to the X12 checkbox.

 3. On the General tab in the Outbound section, select the Enable EDI Validation 
checkbox. 

Set the Transport 

To set the transport, perform the following steps:

Procedure
 1. Go to Partner Management > Partners > Company1.

 2. Click Edit Configurations next to the X12 checkbox.

 3. Go to the Transport tab.

 4. Click Add Outbound Transport.

 5. In the Add Transport dialog, enter HTTP in the Transport Name field.

 6. From the Transport Type dropdown list, select HTTP.

 7. Click Add.

 8. In the URL field, enter the name of the trading partner’s machine. Example: 
machine2.vidgets.com:8800/X12.

 9. Click Save.

Configure the HIPAA Acknowledgements 

To enable HIPAA acknowledgements, perform the following steps:
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Procedure
 1. On the Partner Management tile, click Partners. 

 2. On the Partners page, click Company1.

 3. On the Protocols tab, click Edit Configurations next to the X12 checkbox.

 4. Go to the Acknowledgements tab > HIPAA Acknowledgement.

Note: For more information about HIPAA acknowledgements level, see 
HIPAA Acknowledgement Properties.

 5. In the 824 Application Advice Creation field, select Always.

 6. In the 824 Application Advice Version field, select 004050X166.

 7. In the 277 Health Care Notification Creation field, select Always.

 8. In the 277 Health Care Notification Version field, select 003070X070A1 - 
Unsolicited Claim Status.

 9. Click Save.

Configure the Business Agreement On The Trading 
Partner Machine

Procedure
 1. On the Partner Management tile, click Business Agreements.

 2. On the Business Agreements page, click Create Agreement, which is on the top-right 
corner of the page.

 3. Select Company2 in the Host field and Company1 in the Partner field. 

 4. Click Proceed.

 5. On the Bind Protocol tab, select the X12 checkbox.

 6. Click Edit Configurations next to the X12 checkbox.

 7. Go to the Transports tab and verify that HTTP is selected in the Primary Transport 
dropdown list in the Outbound transport for Host “Company2” area.
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 8. Click Save.

Configure the Private Process On The Trading Partner Machine

For this tutorial, it is not necessary to run a private process on the trading partner 
machine.

Running the Tutorial
To run the tutorial, perform the following step on the trading partner machine:

Procedure
 1. Create a deployment configuration, deploy, and start TIBCO BusinessConnect™ 

Container Edition.

During the deployment process, the default behavior is to start the deployed service. 
For information on deployment, see the TIBCO BusinessConnect™ Container Edition 
Installation and Deployment guide.

On the host machine, perform the following steps:

Procedure
 1. Create a deployment configuration, deploy, and start TIBCO BusinessConnect™ 

Container Edition.

 2. Send the HIPAA 837 Professional transaction from TIBCO Business Studio. See Send 
the HIPAA 837 Professional Transaction.

 3. Verify the results of sending the message. See Expected Results and Viewing Logs.

Send the HIPAA 837 Professional Transaction
The Send HIPAA 837 Request process, performs the following tasks:

 1. Reads a file containing XML data for a HIPAA 837 Professional transaction.

 2. Parses the 837 Professional XML.
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 3. Constructs a request message containing the 837 Professional XML data and sends it 
to BusinessConnect Container Edition - EDI Protocol HIPAA Edition powered by 
Instream.

 4. Logs information if an error occurs sending the request.

Figure 12: Send HIPAA 837 Request Process

Run the Tutorial on the Host Machine

To run the tutorial on the host machine, perform the following steps:

 1. On the Tester tab, click the dropdown icon next to the BWApplication icon.

 2. Select Run Configuration from the dropdown list.

 3. In the Run Configurations dialog, expand BusinessWorks Application > 
BWApplication.

 4. From the list of the processes displayed, you can select one or multiple items based 
on the type of transaction you want to process. In this tutorial, click the Send_837_
Request message.

 5. Click Apply > Run.

You can see BusinessWorks logs on the Console tab.
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Note: If you want to run the process in debug mode, click Debug BWApplication 
icon > Debug Configurations and follow the above procedure from Step 3.

Expected Results
After the 837 transaction is received by the host BusinessConnect Container Edition - EDI 
Protocol HIPAA Edition powered by Instream, the following events occur:

 1. The host BusinessConnect Container Edition converts the XML data to X12 data.

 2. The host  validates the X12 data against the 837 Professional guideline.

 3. The validated X12 data is bundled into an interchange for sending the data to trading 
partner.

 4. The X12 interchange is sent to the trading partner BusinessConnect Container Edition 
using HTTP.

 5. The trading partner  receives the X12 data.

 6. The trading partner  validates the X12 data against the 837 Professional guideline.

 7. The trading partner  converts the X12 data to XML data.

 8. The trading partner  generates TA1, 997, 824, and 277U X12 acknowledgments.

 9. The generated X12 acknowledgments are returned to the host.

 10. The trading partner sends the 837 XML data to its private process.

 11. The host  validates each X12 acknowledgment that it receives against the appropriate 
guideline.

 12. The host  converts each X12 acknowledgment into XML data.

 13. The host  sends the XML data for each acknowledgment to its private process.

 14. The host private process logs the status from each XML data acknowledgment.

What You Can Observe
 l The Send HIPAA 837 Professional Request activity of the Send HIPAA 837 Request 
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process contains the output that indicates the 837 Professional transaction is 
successfully sent to the trading partner.

 l The audit logs in the host and trading partner contain entries for each processing 
state that occurred in BusinessConnect Container Edition. See Viewing Logs.
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Viewing Logs
This section explains how to view the transaction logs in Audit Trail of BusinessConnect 
Container Edition - EDI Protocol HIPAA Edition powered by Instream.

TIBCO® AuditSafe stores information about the messages and documents processed by 
BusinessConnect Container Edition.

To view the logs on the Data Viewer tile, click    Audit Trail >    X12.    

All the transactions are displayed on the    Transactions page.    

Transactions

On the Transactions page, you can perform the following actions:    

 l Sort transactions by columns.      

 l Search for transactions by using Filters      

 l View      Transaction Details

 l Change the columns that you view by selecting the categories from the      Settings 
dialog      

The page displays 20 records with the newest transactions listed first by default. Page 
through the display to see older records. You can sort the transactions by category, or 
search for records of a specific type. The number of records returned is limited to 10,000 
audit events or a maximum of 500 pages. Attempting to select additional pages after 500, 
will return a "No records found" error.    

Sort Transactions

Sort transactions by clicking the arrows on a column (category) heading.    

To reorder the columns, click the category name to select it, and drag it to a different 
location on the page.    

The transactions are sorted by date and time by default, so the newest transactions appear 
at the top of the list.    
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Search for Transactions

The search feature in AuditSafe is powerful and easy to use.    

You can search for values within multiple categories. The search finds matching records 
even if a category (or column) is not displayed. You can hide or show categories by 
selecting them from the      Settings dialog.    

Use the following options to initiate a search action:

 l Use the      Keyword option to search for a term in all the categories.      

 l Searching for values or keywords within the same category is an      OR search.      

For example: Search      Status for In Progress or Completed to find all transactions that 
contain those values.      

 l Searching for values between two or more categories is an      AND search. You can 
combine the two search-types to narrow your results.      

For example: Search      Status for      PROCESSING OR COMPLETED,      AND search      Audit 
Event for      Request Received.      

The system automatically segments your query into OR and AND searches as seen in the 
following example:    

Using Search

Search contains the following options:    

 l Selecting      Time allows you to define a Start and End range for your search.      

 l Selecting      Keyword searches for the term in all categories.      

Search 
Option        

Description        

=        Equals: Finds an exact match for a term. Entering the first few letters will 
list matching options. Select one and press ENTER. If an exact match is not 
available, no items are listed.        

!=        Not Equal to: Use this option to exclude terms from your search.        

~        Like: Enter a few letters to list items containing a matching string.        
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 1. Click the      Select dropdown to choose a category.      

 2. In the      Search Transactions field, select a search option (see above), and enter a 
word.      

 3. As you begin to enter a word, the system displays the available options.      

 4. Select an option and press      ENTER to add it to your query. Continue adding options 
to narrow your returns.      

 5. Once you have created your query, click      Find to list the results.      

 6. Click the      X (Delete) icon to remove a search term.      

Customizing Views

The      Settings icon allows you to select which columns to display.    

Click the gear icon to view the list and check the boxes for the columns that you want to 
view.    

Click      Apply to save your choices. 
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Customize your view using the following options:    

Option        Description        

Group By        Use this option to group results by category. To do this, select a category from 
the dropdown.        

Columns        Check the box next to the category to display the columns you want to view. 
You can also enter a partial word to display all the categories containing that 
string as shown in the following image:       

Transaction Details

Click a transaction in the list to see more details.    

View the transactions using either a Diagram view or a List view.    

Switch between the two views by clicking the icon on the top right.    

The diagram view also displays related transactions.    
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TIBCO Documentation and Support Services
For information about this product, you can read the documentation, contact TIBCO 
Support, and join TIBCO Community.

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the Product Documentation website, 
mainly in HTML and PDF formats.    

The Product Documentation website is updated frequently and is more current than any 
other documentation included with the product.

Product-Specific Documentation

The following documentation for this product is available on the TIBCO BusinessConnect™ 
Container Edition - EDI Protocol HIPAA Edition powered by Instream® Product 
Documentation page:    

 l TIBCO BusinessConnect™ Container Edition - EDI Protocol HIPAA Edition powered by 
Instream® Release Notes

 l TIBCO BusinessConnect™ Container Edition - EDI Protocol HIPAA Edition powered by 
Instream® Installation

 l TIBCO BusinessConnect™ Container Edition - EDI Protocol HIPAA Edition powered by 
Instream® Configuration

Other TIBCO Product Documentation

When working with TIBCO BusinessConnect™ Container Edition - EDI Protocol HIPAA 
Edition powered by Instream®, you may find it useful to read the documentation of the 
following TIBCO products:

 l TIBCO ActiveMatrix BusinessWorks™

 l TIBCO BusinessConnect™ Container Edition

https://docs.tibco.com/
https://docs.tibco.com/
https://docs.tibco.com/products/tibco-businessconnect-container-edition-edi-protocol-hipaa-edition-powered-by-instream
https://docs.tibco.com/products/tibco-businessconnect-container-edition-edi-protocol-hipaa-edition-powered-by-instream
https://docs.tibco.com/products/tibco-businessconnect-container-edition-edi-protocol-hipaa-edition-powered-by-instream
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 l TIBCO BusinessConnect™ Container Edition - EDI Protocol powered by Instream®

 l TIBCO ActiveMatrix BusinessWorks™ Plug-in for BusinessConnect™

 l TIBCO Business Studio™

 l TIBCO Foresight® EDISIM

 l TIBCO Foresight® HIPAA Validator® Desktop

How to Contact Support for TIBCO Products

You can contact the Support team in the following ways:    

 l To access the Support Knowledge Base and getting personalized content about 
products you are interested in, visit our product Support website.     

 l To create a Support case, you must have a valid maintenance or support contract 
with a Cloud Software Group entity. You also need a username and password to log 
in to the product Support website. If you do not have a username, you can request 
one by clicking Register on the website.      

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee 
subject matter experts to share and access their collective experience. TIBCO Community 
offers access to Q&A forums, product wikis, and best practices. It also offers access to 
extensions, adapters, solution accelerators, and tools that extend and enable customers to 
gain full value from TIBCO products. In addition, users can submit and vote on feature 
requests from within the      TIBCO Ideas Portal. For a free registration, go to      
TIBCO Community.    

https://support.tibco.com/s/
https://support.tibco.com/s/
https://ideas.tibco.com/
https://community.tibco.com/
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Legal and Third-Party Notices
SOME CLOUD SOFTWARE GROUP, INC. (“CLOUD SG”) SOFTWARE AND CLOUD SERVICES EMBED, 
BUNDLE, OR OTHERWISE INCLUDE OTHER SOFTWARE, INCLUDING OTHER CLOUD SG SOFTWARE 
(COLLECTIVELY, “INCLUDED SOFTWARE”). USE OF INCLUDED SOFTWARE IS SOLELY TO ENABLE THE 
FUNCTIONALITY (OR PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED CLOUD SG 
SOFTWARE AND/OR CLOUD SERVICES. THE INCLUDED  SOFTWARE IS NOT LICENSED TO BE USED OR 
ACCESSED BY ANY OTHER CLOUD SG SOFTWARE AND/OR CLOUD SERVICES OR FOR ANY OTHER 
PURPOSE.

USE OF CLOUD SG SOFTWARE AND CLOUD SERVICES IS SUBJECT TO THE TERMS AND CONDITIONS 
OF AN AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED AGREEMENT, OR, IF THERE IS NO 
SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER AGREEMENT WHICH IS DISPLAYED WHEN 
ACCESSING, DOWNLOADING, OR INSTALLING THE SOFTWARE OR CLOUD SERVICES (AND WHICH IS 
DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH LICENSE AGREEMENT OR CLICKWRAP 
END USER AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE SOFTWARE. USE 
OF THIS DOCUMENT IS SUBJECT TO THOSE SAME TERMS AND CONDITIONS, AND YOUR USE HEREOF 
SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this 
document may be reproduced in any form without the written authorization of Cloud Software 
Group, Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, ActiveMatrix BusinessWorks, BusinessConnect, Business 
Studio, EDISIM, and TIBCO Business Studio are either registered trademarks or trademarks of Cloud 
Software Group, Inc. in the United States and/or other countries.
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